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About This Document

This document is intended for use by those, particularly in the hardware review
community, who are interested in evaluating AMD64 performance, as
demonstrated by the AMD Athlon™ 64, AMD Athlon 64 X2 and AMD Athlon 64 FX
processors.

Introduction

This document describes AMD’s method of performing processor performance
evaluation, and details the steps taken to arrive at the results posted on the
web.

Audience

This document is intended for use by those, particularly in the hardware review
community, who are interested in evaluating AMD64 technology performance, as
demonstrated by the AMD Athlon 64 and AMD Athlon 64 FX family of processors.

Life of Document

This document is intended for use when comparing the AMD Athlon 64 processor
model 4000+, the AMD Athlon 64 X2 model 4800+, and the AMD Athlon™ 64
FX-57 processors against processors available from other vendors at the time of
publication of this document. As new speed grades become available, this
document may become obsolete or revised as necessary.

About This Document 11
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AMDG64 Processor Architecture

Optimal benchmarking of AMD processors does not require detailed knowledge
of processor or system architecture. However, knowledge of the benefits of
AMD64 processor-based systems will help enable benchmarks to show the
different ways of how this processor performs relative to its competition. AMD
designed a 64-bit processor that offers industry-leading performance and native
compatibility with current 32-bit applications. Architectural improvements
specifically designed to increase instructions per clock (IPC) include:

AMD64 Technology

When utilizing the AMD64 Instruction Set Architecture, 64-bit mode is
designed to offer:

Support for 64-bit operating systems to provide full, transparent, and
simultaneous 32-bit and 64-bit platform application multitasking.

A physical address space that can support systems with up to 1 terabyte of
installed RAM, shattering the 4 gigabyte RAM barrier present on current x86
implementations.

Sixteen, 64-bit general-purpose integer registers that quadruple the general
purpose register space available to applications and device drivers.

Sixteen, 128-bit XMM registers for enhanced multimedia performance to
double the register space of current SSE/SSE2/SSE3 implementations.

Integrated DDR memory controller, as shown in Figure 1 on page 15.

This feature allows for a reduction in memory latency, thereby increasing
overall system performance.

Benchmarks like Business Winstone® and WinRAR Data compression, and
AquaMark3 all help show the benefit of reduced latency.

An advanced HyperTransport™ link, as shown in Figure 2 on page 16.

This feature dramatically improves the I/O bandwidth, enabling much faster
access to peripherals such as hard drives, USB 2.0, and Gigabit Ethernet
cards.

HyperTransport technology enables benchmark programs like Business
Winstone and WinRAR Data compression to illustrate higher processor
performance due to a reduced I/0 interface throttle.

AMD64 Processor Architecture 13
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e Very large level one (L1) and level 2 (L2) on-die cache

- With 128 kbytes of L1 cache and 1 Mbyte of L2 cache, the AMD Athlon 64
processor is able to excel at performing matrix calculations on arrays.

- Programsthat useintensive, large matrix calculations will benefit from fitting
the entire matrix in the L2 cache.

e Processor core clock-for-clock improvements, including larger TLB
(translation look-aside buffers) with reduced latencies and improved branch
prediction through four times the number of bimodal counters in the global
history counter, as compared to seventh-generation processors.

- These features drive improvements to the IPC, delivering a more efficient
pipeline for CPU-intensive applications.

- CPU-intensive games like Comanche 4 and Unreal Tournament benefit from
these core improvements.

e Introduction of the SSE3 instruction set, which along with support of
3DNow!™ Professional, (SSE and 3DNow! Enhanced) completes support for
all industry-standard x86 32-bit instruction set extensions.

e 64-bit processing
- A 64-bit address and data set enables the processor to process in the

terabyte space.
— Microsoft® Windows® XP 64-Bit Edition for 64-Bit Extended Systems
supports up to 32 GB of RAM and up to 16 TB of virtual memory.

- Gamers can preload entire three-dimensional worlds into memory for a fully
immersive experience.

- Amateurs can edit home videos with ease, providing professional results.
- The 64-bit space is designed to bring home the digital experience.

e The Industry’s first true on-die dual core x86 PC processor
- Inter-core communication at CPU speed
- Direct access to memory controller and HyperTransport technology link

14 AMDG64 Processor Architecture
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Figure 1 is a generic diagram showing the architecture that is internal to all
AMD64 technology-based processors.

¢ AMDG64 Processor )
Architecture
DDR Memory

Controller

L1
Instructio
Cache

L2
Cache
L1
Data
Cache

HyperTransport™

technology

- J

Figure 1. AMDG64 Processor Architecture

AMD64 Processor Architecture 15
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Figure 2 is a block diagram of a system using HyperTransport™ technology.

HyperTransport™ I/O links

» Up to 1GB bandwidth available

» Extensive data protection/management
* Integrated power management

* Building block structure

» Up to N devices supported in chain

Device #0

DDR Memory

AGP3.0/PCL-x® AV

Interface

AGP3.0/PCI-X®
Device #1 Graphics Adapter

Device #N

IEEE 1394

PCI (33 MHz/32-bit) pCI-x® (up to 266 MHz/64-bit) Bus

101S
1018
1018

Figure 2. HyperTransport™ Technology Block Diagram

16
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Figure 3 is a block diagram of the AMD Athlon™ 64 X2 Dual-Core processor
architecture.

Dual-Core Processor Architecture

Replaces Address, Data and Control Bus

The industry’s first true on- HyperTransport™

die dual-core x86
processor

* Inter-core communication
at CPU speed

« Direct access to memory
controller and
HyperTransport™
technology link

Enhanced Virus Protection
for Windows® XP SP2

 Designed to help prevent
the spread of certain
viruses, like MSBlaster and
Slammer

« Significantly reduces the
cost and down time
associated with similar
viruses and improves the
protection of computers
and personal information
against certain PC viruses

AMDG64 Architecture delivers
leading-edge software
performance

 Both high-performance and
32- and 64-bit computing

» Experience dual-core
performance today with no
hardware changes (a BIOS
update may be required)

DDR Memory
Controller

HyperTransport™
Technology

Cross Bar Switch

System Request Queue

technology accelerates the
system bus for high-speed
I/O communication

8.0 GB/s of available
system bandwidth

2000 MHz System Bus

AMD Athlon™ 64 X2 Dual-
Core processors are true
dual core.

Independent L2 cache

Intelligent System Request
Queue and integrated
Cross Bar Switch

Cool'n’Quiet™ technology
for quieter computer and
lower power costs

Recognized by the U.S.
Environmental Protection
Agency in 2005 for the
advancement of energy-
efficient computer
technology

Figure 3. AMD Athlon™ 64 X2 Dual-Core Processor Architecture

AMD64 Processor Architecture
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AMD's Benchmarking Methodology

AMD assembled a suite of industry standard benchmarks and applications
designed to reflect typical end user applications. Specifically, AMD has identified
three usage models which we believe best exemplify the commercial and
consumer end-user PC experience:

1. Office Productivity
2. Digital Media
3. Gaming

From this list, AMD chose the following benchmarks and applications to
represent these end-user experiences. AMD recommends the use of the
following benchmarks for proper, balanced, real-world performance analysis.

Office Productivity

AMD Athlon™ 64 and AMD Athlon 64 X2 processors run multiple tasks efficiently.
Work productivity may increase because you can perform more tasks and wait
less for an application to deliver a response. The following applications simulate
a workload likely to be seen in an office workplace environment.

« Business Winstone® 2004 v1.01 =~ Microsoft Access 2002
— Microsoft® Internet Explorer 6 — Microsoft Excel 2002
—  Microsoft Outlook 2002 SP-2 - Microsoft Internet Explorer 6
— Microsoft Project 2002 - Microsoft Outlook 2002
- Microsoft Access 2002 SP-2 ~ Microsoft Word 2002
- Microsoft PowerPoint 2002 SP-2 - Network Associates Mcafee

VirusScan 7.0

- ScanSoft Dragon Naturally Speaking
6 Preferred

- WinZip Computing WinZip 8.1

— Microsoft Excel 2002 SP-2

- Microsoft FrontPage 2002 SP-2

— Microsoft Word 2002 SP-2

— Norton AntiVirus Professional Edition

2003 e WIinRAR ver 3.42
- WinZip 8.1 SR-1 e PCWorldBench 5 (May 10, 2004 edition
e Business Winstone 2004 Multitasking with SP2 reg edit)
v1.01 - ACD Systems ACDSee PowerPack 5.0
- Multitasks applications found in - Adobe PhotoShop 7.0.1
Business Winstone 2004 v1.01 - Adobe Premiere 6.5
e SYsmark® 2004, Office Productivity - Ahead Nero Software Nero Express

6.0.0.3
— Discreet 3ds max 5.1 (DirectX)
- Discreet 3ds max 5.1 (OpenGL)

version 1.0 patch 2
- Adobe® Acrobat® 5.0.5

AMD's Benchmarking Methodology 19
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— Microsoft Office XP - SP2

—  Microsoft Windows® Media Encoder
9.0

- Mozilla 1.4

- Musicmatch Jukebox 7.10

- Roxio VideoWave Movie Creator 1.5
-  WinZip Computing WinZip 8.1
Remote collaboration (Multi-application

Netmeeting ver. 3.01 + Windows Media
Encoder ver. 9.00.00.2980)

- Microsoft Netmeeting launched on
two systems

30579 Rev. 3.71 June 2005

- Host system shares a Powerpoint
presentation on the target system

— Microsoft Windows Media Encoder
converts a MPEG2 file to Mpeg4

Travel Ready (Multi-application
Microsoft Publisher 2003 ver.
11.5525.5606 + Nero Recoder ver
3.1.0.0)

- Microsoft Publisher runs with a
scripted input to create a newsletter

— Nerorecoderrunstoconverta MPEG2
file to Nero’s MPEG4 format

The Office Productivity suite now includes two likely operating scenarios. The
first is a remote collaboration scenario. In this scenario, Microsoft Netmeeting is
launched on two systems. The host system then shares a PowerPoint
presentation on the target system.

The other scenario combines Microsoft Publisher 2003 (version 11.5525.5606)
with Nero Recorder (version 3.1.0.0). The scenario is a script that creates a
newsletter while Nero runs and converts a MPEG2 file into Nero’s MPEG4 format.

Digital Media

AMDG64 processor-based systems take advantage of the newly-designed system
features and deliver outstanding performance for digital creation and playback.

Content Creation Winstone® 2004
(version 1.01)

- Adobe Photoshop® 7.01, Adobe
Premiere 6.50

- Macromedia Director MX 9.0,
Macromedia Dreamweaver MX 6.1

— Microsoft Windows Media Encoder 9
version 9.00.00.2980

- Newtek LightWave 3d 7.5b
- Steinberg Wave Lab 4.0

Dr. Divx (version 1.06)
RazorLAME ver. 1.1.5

POV-Ray version 3.7.4
- 3D Rendering program

SYSmark® 2004 Internet Content
Creation

- Adobe Photoshop 7.01, Adobe
Premiere 6.5, Adobe After Effects 5.5

— Discrete 3ds max 5.1

— Network Associates Mcafee VirusScan
7.0

- WinZip Computing WinZip 8.1
- Macromedia Dreamweaver MX,
Macromedia Flash MX

Panorama Factory version 3.3
- Photo stitching program
Sony Vegas Studio ver 4.0

- Video File Conversion

Microsoft Movie Maker ver 5.1
— Still picture to movie conversion.

20
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Computer Gaming

The high performance benefits will amaze computer gamers. The following
benchmarks focus on the three dimensional capabilities of a system:

Note: Computer gaming may reveal limitations in a graphics card and may not truly represent
relative processor performance.

- 3DMark® 2003 (360 patch) (Hardware and Software)

- 3DMark 2005 (120 patch) (Hardware and Software)

- Crafty version 19.19

- Doom3 version 1.1

- Far Cry version 1.3.1 (Pier)

- Half-Life 2 version 1.0.1.0 (at_coast 05 rev7.dem, and at prison 05 rev7.dem)
- Pain Killer version 1.64

- Quake III version 1.11

- Return to Castle Wolfenstein Enimy Territory version 2.60

- Splinter Cell version 1.2b (tests1_1_1and 1_1_2)

- Star Wars - Jedi Knight II: Jedi Outcast version 1.04

- Unreal Tournament 2004 version 3355 (Flyby and Botmatch)

AMD's Benchmarking Methodology 21
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Optimal System Configuration
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This section describes the configurations used by AMD to perform the
benchmarks. Systems that conform to the configurations shown in Table 1,
Table 2 Table 3 on page 23, Table 4 on page 24, and Table 5 on page 24 are the

most likely to obtain optimal system performance.

Table 1. AMD Athlon™ 64 Processor 4000+ System Configuration

Component Manufacturer Model Description
AMD Athlon™ 64 .

Processor AMD Processor 4000+ Clock frequency: 2.4 GHz
Operating . ® Windows® xp - -

Version 2002 (Service Pack 2
System Microsoft Professional ( )

nForce4 SLI MCP, SATA driver NVIDIA
Motherboard Asus A8N-SLI Deluxe 5.10.2600.507
Hard drive Western Digital Raptor (2x) SATA RAID 10k RPM 36.0 GB
. CMX512-
RAM memory Corsair 3200XLPRO 2 X 512 MB DIMM PC3500 Module
Video Card NVIDIA FX6800 ULTRA PCI- 256 MB Onboard DDR RAM, Video Driver
Express 7.1.8.4

Table 2. AMD Athlon™ 64 Processor X2 4800+ System Configuration

Component Manufacturer Model Description
AMD Athlon™ 64 .
Processor AMD Processor X2 4800+ Clock frequency: 2.4 GHz
Operating . ® Windows® xp - -
Version 2002 (Service Pack 2
System Microsoft Professional ( )
nForce4 SLI MCP, SATA driver NVDIA
Motherboard Asus A8N-SLI Deluxe 5.10.2600.507
Hard drive Western Digital Raptor (2x) SATA RAID 10k RPM 36.0 GB
. CMX512-
RAM memory Corsair 3200XLPRO 2 X 512 MB DIMM PC3500 Module
Video Card NVIDIA FX6800 ULTRA PCI- 256 MB Onboard DDR RAM, Video Driver
Express 7.1.8.4
22 AMD's Benchmarking Methodology
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Table 3. AMD Athlon™ 64 FX-57 Processor System Configuration

Component | Manufacturer Model Description
™ _
Processor AMD AMD Atllnlon 64 FX-57 Clock frequency: 2.6 GHz
rocessor

Operatin . )

P 9 Microsoft® Windows® XP Professional Version 2002 (Service Pack 2)
System

nForce4 SLI MCP, SATA driver NVIDIA
Motherboard Asus A8N-SLI Deluxe 510.2600.507
Hard drive Western Digital Raptor (2x) SATA RAID 10k RPM 36.0 GB
RAM memory Corsair CMX512-3200XLPRO 2 X 512 MB DIMM PC3500 Module
Video Card NVIDIA FX6800 ULTRA PCI-Express  2°© MB Onboard DDR RAM, Video
Driver 7.1.8.4

Note:

®

1. This version is for use in the upcoming Windows ™~ 64-bit operating environment.

AMD's Benchmarking Methodology 23
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Table 4. Intel Pentium® 4 Processor 3.8 GHz System Configurations

Component | Manufacturer Model Description
Intel Pentium® 4 processor Clock Frequency: 3.8 GHz,
Processor Intel with HT technology 800 MHz System Bus
Operatin . .
gystemg Microsoft® | windows® XP Professional Version 2002 (Service Pack 2)
Motherboard Intel 925XCV, BIOS Intel i925 Chipset, Intel 82801FR
CV92510A.86A.0218 SATA Raid Controller 4.6.06758
Hard drive | Western Digital Raptor 2 X SATA RAID 10 k RPM 36.0 GB
RAM memory Corsair CM2X512-5400C4PRO 2 X 512 MB DIMM Module
Video Card NVIDIA FX6800 Ultra PCI-Express 256 MB Onboard DDR RAM,

Video Driver 7.1.8.4

Table 5. Intel Pentium® 4 Processor Extreme Edition 3.73 GHz System
Configurations

Component | Manufacturer Model Description
Intel Pentium® 4 processor Clock Frequency: 3.73 GHz,
Processor Intel with HT technology 800 MHz System Bus
Operatin . .
gystemg Microsoft® | windows® XP Professional Version 2002 (Service Pack 2)
Motherboard Intel 925XCV, BIOS Intel i925 Chipset, Intel 82801FR
CV92510A.86A.0218 SATA Raid Controller 4.6.06758
Hard drive | Western Digital Raptor 2 X SATA RAID 10 k RPM 36.0 GB
RAM memory Corsair CM2X512-5400C4PRO 2 X 512 MB DIMM Module
- 256 MB Onboard DDR RAM,
Video Card NVIDIA FX6800 Ultra PCI-Express Video Driver 7.1.8.4

The following sections detail how to set up the BIOS and the operating system,
and which settings AMD uses for running each benchmark.
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BIOS Configuration for the AMD Athlon™ 64
Processors on the ASUS A8N SLI Deluxe

The following setup instructions apply to all AMD Athlon™ 64 processor models
in this document. Modifications should be made to any other configuration where
applicable.

Use the following steps to set up the BIOS for optimal operation with the

AMD Athlon 64 processors. Use the arrow keys (Right Arrow —, Left Arrow <—,
Up Arrow T, and Down Arrow ) to navigate through the BIOS screens, to select
menus, and to highlight specific options to change. For most options, use the +
and - keys to change the setting. After selecting each setting press Enter to set
the selection and move to the next step.

1. Press Del to enter the BIOS setup 6. Select the Onboard Device
screens Configuration > NVRAID
Configuration menu.

a. For RAID Enable, select Enabled.
b. For First SATA Master, select

2. Select Exit menu.
a. Select Load Setup Defaults.
b. PressY.

g d d Enabled.

3. Under Advanced > CPU

Configuration > HyperTransport c. Ec:aif:gnd SATA Master, select
Frequency, select 5X. o

4. Select the Advanced > CPU d. E%ra.:;l:e";jd SATA Master, select
Configuration > DRAM )
Configuration menu. e. For Forth SATA Master, select

Enabled.

c. For Timing Mode, select Manual.
7. Press Esc to reach the Onboard

d. For Memclock Index Value . . .
Device Configuration menu.

(MHz), select 400MHz.

8. Select the Onboard Device
. For CAS# latency (Tcl lect 5T.
e. ror y (Tel), selec Configuration > USB Configuration

f. For Min Ras# active time (TRAS), menu.
select 5T. a. For USB Controller, select
g. For RAS# to CAS# delay (Trcd), Disabled.
select 2T.
. b. Press Esc to reach the Onboard
h. Fol" Row precharge Time (Trp), Device Configuration menu.
select 2T.
o c. For Onboard NV Lan, select
i. For 1T/2T Memory Timing, select Disabled.
iT.
d. For PCI IEEE 139443, select
5. Press Esc twice to return to the main Disabled.
menu.

e. For Silicon SATA Controller, select
Disabled.
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f. For Serial Portl Address, select
Disabled.

g. For Parallel Port Address, select
Disabled.

h. For Game Port Address, select
Disabled.

i. For Midi Port Address, select
Disabled.

9. Press Esc to reach the Advanced
menu.

30579 Rev. 3.71 June 2005

10. Select the Speech Configuration
menu.

a. For Speech IC Reporter, select
Disable.

11. Press Esc twice to exit to the Main
menu.

12. Press F10 to Save and Exit.
13. Press Enter to select Yes.

Operating System Configuration

The following setup instructions apply to all processors. The operating system
should be installed on the platform using an NTFS partition. The default settings
should be used during the installation. The following system setup instructions
can be used to fully achieve optimal system performance.

Operating System Setup

1. During the boot sequence, press Enter
to boot the system from the CD-ROM.

2. Press F6 to install the drivers for serial
ATA.

3. Press S to specify an additional device.

Insert the floppy disk that containst the
downloaded ATA drivers.

Note: Leave the disk in the drive until the
procedure asks you to reboot. The
disk is needed during the initial
setup sequence.

Press Enter to continue.

Select WinXP NVIDIA Class Raid
Driver and press Enter.

7. Press S to specify an additional device.

Select WinXP NVIDIA Nforce
Storage Controller.

9. Press S to specify and additional
device.

10. Select WinXP NVIDIA Nforce
Storage Controller.

11. Press Enter to continue the installation
of Windows® XP PRO software.

12. Press F8 to agree to the license
agreement.

Note: If the drive is not yet formatted, or
formatted with another operating
system, steps 13 and 14 do not
apply. Skip to step 15.

13. Select ESC=Don’t Repair to install a
fresh copy of Windows XP without
repairing.

14. Select D=Delete Partition to delete
all existing partitions.

Note: If there are no existing partitions,
step 14 will not appear.

15. Select C to create a partition.

a. Enter 35000 as the partition size
field for the first partition.
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16.

17.

18.

19.
20.

21.

22.

23.

24.

b. Press the Down Arrow key until the
unpartitioned space is highlighted
and then press C to create this
partition.

c. Press Enter to accept the default

value. There will be 8 Mbytes of
unpartitioned space.

Select Format the partition using
the NTFS (Quick) file system.

Click Yes to verify installation of serial
all ATA drivers.

Click Next to continue with Regional
and Language Options.

Type in your name and organization.

Type in a valid Windows XP product key
and click Next.

Type the administrator password twice
and click Next.

Click Next on Date and Time
Settings.

Click Next on Networking Settings
to confirm Typical Settings.

Click Next on Workgroup and
Computer Domain.

25.
26.

27.

28.

29.

30.
31.
32.
33.
34.
35.
36.
37.
38.

39.

AMD Processor Performance Evaluation Guide

Click Ok to confirm display settings.

Click Ok to confirm new monitor
settings.

Click Next to continue with Welcome
to Microsoft® Windows®.

Click Skip to bypass Networking
Settings.

Select No to bypass Activate
Windows and click Next.

Type in your user name and click Next.
Click Finish.

Open My Computer.

Right-click on drive D:.

Click Format.

Select Quick format.

Click Start.

Click Ok to confirm format.

Click Ok to acknowledge the message
Format Complete.

Click Close.

Install Windows® XP Service Pack 2

1.

v p LN

Install Microsoft Windows XP Service
Pack 2 Network Installation
self-extracting cabinet:
WindowsXP-KB835935-SP2-ENU.exe

Click Next to continue.
Select I agree and click Next.
Click Next.

Click Finish to restart computer on the
Help Protect MY PC screen.

Select Not right Now and click Next.

7.

10.

11.

12.

Close the balloon Your computer
might be at risk in the Windows
security center window.

Select Windows firewall under
manage security settings.

Select Off and click Ok.

Select Change the way security
center alerts me, under Resources.

Deselect all the boxes on the dialog
box, and click OK.

Close the window.
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13.

14.

15.
16.
17.
18.

19.
20.
21.
22.
23.
24.
25.
26.

27.

28.

29.

Right-click on My Computer on the
Desktop.

Select Properties and click the
Advanced tab.

Select Performance Options.
Click Settings and click Advanced.
Click Change for Virtual Memory.

Select drive C: and select No paging
file under Change virtual memory

(paging file).

Click Set.

Select drive D

Select Custom size.

Type 1536 MB for Initial Size.
Type 3072 MB for Maximum Size.
Click Set.

Click Ok and restart computer.

Right-click My Computer on the
desktop.

Select Properties and click
Automatic Updates.

Select Turn off Automatic Updating.
I want to update my computer
manually.

Click Apply.

30.

31.
32.

33.

34.

35.
36.
37.
38.

39.

40.
41.

42.

43.

44,

45,
46.
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Click System Restore and select Turn
off System Restore on all drives.

Click Apply.

Click Yes to verify Turn Off System
Restore.

Right-click My Computer icon on the
desktop.

Select Properties and click the
Advanced tab.

Click Settings under Performance.
Select Adjust for best performance.
Click Apply.

Right-click the task bar and select
Properties.

Deselect Keep the taskbar on top of
other Windows.

Click Apply.

Open the Control Panel and
double-click Power Options.

Select Always On from Power
Schemes and select Never to Turn
off monitor.

Click Apply.

Right-click on the desktop and select
Properties.

Click Screen Saver and select None.
Click Apply.

Install Asus A8n-SLI Deluxe Motherboard Drivers

1.

2
3
4

Install the
Nforce_6.36_winxp2k_whql_english.exe

chipset drivers.

. Double-click the .exe file.

. Click Run to start the installation.
. Click Yes to the antivirus window.
5.

Click Yes to agree to the license.

6.
7.

10.
11.

Click Next.

Click Next to install default
components.

Click Next to install NVIDIA IDE SW.
Click Yes to install NVIDIA IDE SW.
Click No to install NVIDIA Firewall.
Click Finish to reboot the system.
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NVIDIA Video Card Setup

1.

10.

11.
12.

Download the video card driver from
the http://www.nvidia.com Web site.

Install the driver:
71.84_win2kxp_english.exe

Click Yes to continue when asked if
antivirus software has been installed.

Click Yes at the next window.

Select the button next to I accept the
terms in the license agreement.

Click Next to accept the license
agreement terms.

Click Next to install the shield wizard.
Click Next to continue the setup.
Click Yes to accept the license.

Click Continue anyway on hardware
installation window.

Click Yes to restart the computer.

Right-click on the desktop and select
the Properties sub-menu item.

13.
14.
15.

16.
17.
18.

19.

20.

21.

22.
23.
24,
25.
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Select the Settings tab.
Change color depth to 32-bit.

Change the screen resolution to 1024
by 768 pixels.

Click Apply to implement settings.
Click Yes to save settings.

Select the Monitor tab and select
85 Hz for Set Screen Refresh.

Select the GeForce FX 6800 Ultra
tab.

Select OpenGL Settings under
Performance and Quality Settings.

Select Vertical Sync, and deselect
Application Control.

Do not change other OpenGL settings.
Click OK.

Click Yes to keep settings.

Click OK to close window.

Your operating system should now be configured properly.
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Benchmark Configuration and Testing

With a properly configured system, benchmarking can begin. Each installation
program is located on your install disk and is subject to the licensing terms
contained therein. Several benchmarks in this test suite are run with scripts
created at AMD. All scripts are available upon request. Send an email to
AMDG64.info@AMD.com with all requests for the scripts. A text version of the
scripts are included in an appendix.

The following procedures are recommended to achieve optimal and accurate
benchmark scores:

Office Productivity

BAPCO® sYSmark® 2004 Internet Content Creation and Office
Productivity

Note: Results for both Internet Content 8. Click Next at the Select Program

Creation and Office Productivity are Folder screen.
generated during each run of the 9. Click Yes at the Question screen.
benchmark. . o
1. Install the BAPCO® sysmark® 2004 10. Click Finish at the Install Complete
screen.
DVD.
2. Click Run on the Open File Security Install the Patch:
Warning dialog box. 1. Double-click on the patch:
3. Run the setup to install SYSmark 2004:| Sysmark2004Patch2.exe
c:\sm2004src\setup.exe 2. Click RUN.
Click Next at the Welcome screen. 3. Click Yes to install the patch.
5. Read the license agreement at the 4. Click Finish.

Licence screen, and select I accept,

then click Next. Run the Benchmark:

6. Click Next at the Customer 1. Execute SYSmark 2004 from the
Information screen. Windows Start menu.

7. Click Next at the Destination Directory | 5 (lick Run.
screen.

Click Official Run.
Type project name and click Ok.
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Ziff Davis Media Inc. Business Winstone® 2004

1. Select Install in the directory where
Business Winstone is located.

2. Click Run on the Open File Security
Warning dialog box.

3. Click Business Winstone 2004.
Click Next at the Welcome screen.

5. Click Next at the Choose Destination
Location screen.

6. Click Yes at the Confirm New Directory
screen.

7. Select Copy Multimedia Content
Support Files on the Select New
Components screen, then click Next.

8. Click Next at the Program Folders

screen.

9. C(Click Next at the Start Copying Files
screen.

10. Click Finish at the Setup Complete
screen.

11. Close the readme file.

Install the Patch:

1. Double-click on the patch to install:
BWS0401up.exe.

2. Click Run on the Open File Security
Warning dialog box.

3. Click Yes.
Click Next.
5. Click Yes.

6.
7.
8.

10.

11.

12.

Click Next.
Click Finish.

Copy the wsbp2004.wsr file to
c:\PCMBench\BWS2004\TESTS\Busine
ss\appsetup.

Run the Benchmark:

Execute Ziff Davis Media Inc.’s Content
Creation Winstone 2004 from the Start
menu.

Read the licence and select Proceed,
then click Next.

Click Yes at the Registration screen.

Select the clock icon next to the
1. Run item on the Functions dialog
screen.

Click Next to run System Configuration
Problem Analysis.

Click Next for Minimum Resource
Requirements.

Click Next for Other Requirements.
Click Next for Other Requirements.
Click Next for Other Requirements.

Click Next for Content Creation
Winstone Requirements.

Click Finish for System Configuration
Problem.

Click Ok for Automated Defrag.

Ziff Davis Media, Inc. Business Multitasking Winstone® 2004

1. If benchmark is not installed from
Veritest Business Winstone 2004
testing, proceed with the steps below.
If it is installed, proceed to “Run the
Benchmark:” on page 32.

2.

Select Install in the directory where
Business Winstone is located.

Click Run on the Open File Security
Warning dialog box.

Click Business Winstone 2004.
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5. Click Next at the Welcome screen.

Click Next at the Choose Destination
Location screen.

7. Click Yes at the Confirm New Directory
screen.

8. Select Copy Multimedia Content
Support Files on the Select New
Components screen, then click Next.

9. Click Next at the Program Folders
screen.

10. Click Next at the Start Copying Files
screen.

11. Click Finish at the Setup Complete
screen.

12. Close the readme.txt file.

Install the Patch:

1. Double-click on the patch to install:
BWS0401up.exe.

@

Copy the wsbp2004.wsr file to:
c:\PCMBench\BWS2004\TESTS\Busine
ss\appsetup.

Run the Benchmark:

1. Execute Ziff Davis Media Inc.’s Content
Creation Winstone 2004 from Start
menu.

2. Read the licence and select Proceed,
then click Next.

3. Click Yes at the Registration screen.

Click in the pull down menu next to the
1. Run item and select Multitasking
Test at the Function dialog box.

5. Select the clock icon next to the
1. Run item on the Functions dialog
screen.

6. Click Next to run System Configuration
Problem Analysis.

7. Click Next for Minimum Resource

2. Click Run on the Open File Security Requirements.

Warning dialog box. Click Next for Other Requirements.
3. Click Yes. Click Next for Other Requirements.
4. Click Next. 10. Click Next for Other Requirements.
>. Click Yes. 11. Click Next for Content Creation
6. Click Next. Winstone Requirements.
7. Click Finish. 12. Click Finish for System Configuration

Problem.
13. Click Ok for Automated Defrag.

PCWorldBench

Note: This benchmark is not publicly available. It is used
only with the express permission of PCWorld.

Insert CD1 into the hard drive.
Click Next to Welcome note.
Click Yes at license window.
Click Next destination location.

uaua ph W N B

Click Next at select program folder.

Insert appropriate CDs when required.
Click Finish.
8. Click Finish to reboot.

Install the Patch:

1. Right click on the file wb5-12aug04
and select Merge.
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LA

Click Run on the Open File security
warning dialog box.

Click Yes to Are you sure?
Click OK to the registry editor window.

Setup PCWorldBench

Double-click worldbenchs configuration
utility.

Click Defaults.
Click OK at updates to taskbar error.
Click Defaults.

Click Finish in the window, and your
system will reboot.

Click exit after reboot.

N o u A
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Run PCworldbench:

Double click worldbenchtm 5 the
Real-World System Benchmark icon

Enter the appropriate data in the
Vendor and Model edit box in the upper
right corner.

Enter system ID in system id box in the
upper right corner.

Click Full run.
Click OK to warning window.
Click OK to information window.

Enter administrator password if exists,
then click OK.

System will reboot, and the test will
run.

Remote Collaboration (Multi-Application Netmeeting + Windows® Media
Encode)

Note: This benchmark requires the setup of two machines. A crossover Ethernet cable long enough to connect both
computers is required for this test. Each additional piece of software must be installed before the script can execute

N

completely.

Label one machine Client and the other
Host.

Steps 3 through 19 are to be peformed
on the client machine.

Setup the resolution on the machine.
Right click on the desktop.

Click on the display properties.
Select the settings tab.

Change resolution to 1280x1024.
Click OK.

Select RUN from start menu.

. Type CONF.

. Click Next.

. Enter the user information click Next.
. Select Do not list my name in directory.
. Select local area network, Click Next.

15.

16.
17.

18.
19.

20.

21.
22.
23.
24,
25.
26.

Click Next to each question in the
audio tuning wizard.

Click Finish.

Connect the crossover Ethernet cable
from the client to the server computer.

Click on the netmeeting on desktop.

Select call from menu, select
automatically accept calls.

Steps 21 through 55 are to be
peformed only on the server machine.

Select RUN from start menu.

Type CONF.

Click Next.

Enter the user information click Next.
Select Do not list my name in directory.
Select Local Area Network.
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27. Click Next to each question.
28. Click Finish.

Install Moonlight Codec

29. Double click moonlight user pro 1.0
prerelease.exe (demo version).

30.
31.
32.
33.
34.
35.
36.
37.

Click Run at security error.

Click Next at welcome screen.

Select Yes, I agree... then click next.
Click Next on install location.

Click Next on program group window.
Click Next at ready to install.
Unselect Run register, click Finish.

Run Moonlight Component Manager
from the Start menu for moonlight.

Click Next.
Click Finish.

38.
39.

Install Windows® Media Encoder 9

40. Download from Microsoft: nttp://
www.microsoft.com/windows/

windowsmedia/9series/encoder/
default.aspx

Click Next at the welcome screen.

41.
42.
43.
44,
45.

Select I accept the user license.
Click Next twice.

Click Install.

Click Finish.

Install Windows® PowerPoint
viewer

46. Download the PowerPoint viewer from
Microsoft:
http://www.microsoft.com/downloads/
details.aspx?FamilyID=428d5727-43ab-4f
24-90b7-a94784af71a4&displaylang=en
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47.
48.
49.

Double-click ppviewer.exe.
Click Run at security.

Click Yes at install office PowerPoint

view2003.
50. Clock OK at completion.

51. Double click on PowerPoint viewer from

start menu, all programs.
52.
53.
54.
55.

Click Accept at license agreement.
Click Cancel at the file open box.
Close PowerPoint viewer application.

Copy the folder msoft_MEDIA_encode
from the AMD CD to c:\.

To Run Benchmark
Open an explorer window.

2. Navigate to:
c:\msoft_MEDIA_encode\netmeetingte
stfiles\wmeplusnm.

3. Edit the wmeplusnm.bat file to make
sure the IP address (the first IP
address in the file) is the client system
IP address.

4. Double-click the netmeeting icon in the
server system.

5. Enter the IP address of the client
system.

Click Call.

7. Netmeeting should connect to the
client. If the connection fails, ensure
that the IP addresses are correct on
both the host and the client, and that
the cable is correctly connected.

Close Netmeeting on server.
9. Double-click wmeplusnm.bat.

10. Results are located in

c:\msoft_MEDIA_encode\netmeetingte
stfiles\wmeplusnm\wmeout.csv.
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Travel Ready Scenario (Multi-Application Microsoft® Publisher + Nero
Recoder)

® N kW

10.

11.
12.
13.
14.

Install Nero Recorder
Purchase Nero Recoder from Nero

Install Nero recoder according to
manufacturers instructions.

Copy from the AMD CD the clipart
folder to c:\.

Copy from the AMD CD the pubrecode
folder to c:\.

Copy from the AMD CD the
recodebench folder to c:\.
Install Microsoft® Publisher

Purchase Microsoft® Publisher from
Microsoft.

Install Microsoft® Publisher by
selecting the Microsoft Publisher option
during the install routine for Microsoft®
Office Professional Edition 2003.

Enter the product key.

Click Next.

Click Next at user information.
Select I Accept License.
Select Custom Install.

Unselect all applications except
Microsoft Publisher.

Select Choose Advance
Customization of Applications.
Ensure that Microsoft Publisher is
selected for install.

On the next screen select Microsoft
Publisher.

Select Run from my computer.
Select Office shared features.
Select Run from my computer.
Select Office tools.

15.
16.
17.
18.
19.
20.

21.

22.

23.

24,

25.

26.

27.
28.
29.

30.

31.

Select Run from my computer.
Click Next.

Click Install.

Click Finish.

Setup clipart manager.

From start menu select all programs,
Microsoft office, Microsoft office tool,
select Microsoft clip organizer.

At the welcome screen click Now to
scan for files.

From the main menu bar, select File >
Add clips to organizer >
Automatically.

Click OK to add clips to organizer.
Close the clipart application.

Click Start > All programs >
Microsoft Office > Microsoft
Publisher 2003.

From the main menu, select file, then
click new.

Click Website and email.
Click email.

Click on the first template under
newsletter.

At Personal information screen. Select
never show this dialog and click OK

Close Microsoft Publisher.

To Run Benchmark

Open an explorer window to
C:\pubrecode.

Double-click recodebench.bat.

Obtain scores from the
c:\recodebench\result.csv.
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WinRAR

1.

7.
8.
9.
10.

Install
activePerl-5.8.6.811-mswin32-x86

Click Next to begin.

Choose I accept the terms in the
license agreement and click Next.

Click Next for default install.
Click Next on the privacy policy.

Click Next to accept the default
options.

Click Install to continue.

Click Finish to complete install.
Double Click winrar342.exe .
Click Install to continue.

Digital Media

11.
12.
13.

14.

15.

16.

1.

Click Ok to default setup.
Click Done to complete install.

Double-click My computer and select
the c:\ drive.

Click File menu, choose New folder
and create rartest.

Copy rartestpl file from CD to new
folder.

Copy NPRP2CDcontent, except for the
DIVX and VOB files to the new folder.

To run the benchmark:

Double-click the rartestpl file which
creates a directory with a text file with
the test results.

Ziff Davis Media Inc.’s Content Creation Winstone® 2004

1.

Select install in the directory where
Winstone is located.

Click Run on the Open File Security
Warning dialog box.

Click Content Creation Winstone
2004.

Click Next at the Welcome screen.

Click Next at the Choose Destination
Location screen.

Click Next at the Confirm New
Directory screen.

Select Copy Multimedia Content
Creation Support Files on the Select
New Components screen, then click
Next.

Click Next at the Program Folders
screen.

9.

10.

11.

12.

13.

14.

15.

Click Next at the Start Copying Files
screen.

Click Next at the Welcome to Media
Encoder 9 Series setup screen.

Read the license agreement on the
EULA screen, select I accept the
terms of this agreement, then click
Next.

Click Next at the Installation Folder
screen.

Click Install at the Ready to Install
screen.

Click Finish at the Completing the
Windows Media Encoder 9 Series setup
wizard screen.

Click OK at the Windows Media
Encoder 9 Installation Completed
Successfully screen.
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16. Click Finish at the Setup Complete 4. Select the clock icon next to the

screen. 1. Run item on the Functions dialog
. screen.

17. Close the readme file.

5. Click Next to run System Configuration
Install the Patch: Problem Analysis.

1. Double-click on the patch to install: 6. Click Next for Minimum Resource

MCC0401up.exe. Requirements.

2. Click Run on the Open File Security | 7. Click Next for each Other
Warning dialog box. Requirements question.

3. Click Yes. 8. Click Next for Content Creation

4. Click Next. Winstone Requirements.

5. Click Next. 9. Click Finish for System Configuration

Problem.

6. Click Yes. ]

10. Click Ok for Automated Defrag.

7. Click Next.

) Note: Program will run until Adobe Premier

8. Click Next. tests for the first time.

9. Click Finish. 1. Click Change Settings at the Data

Execution Prevention screen.
Run the benchmark: ) ]
] ) ] 2. Check the box in the window.

1. Execute Ziff Davis Media Inc.’s Content _

Creation Winstone 2004 from the Start| 3. Click OK.
menu. 4. Click Close Message.

2. Read the licence agreement, and select| 5. Click Don’t Send on the error report
Proceed, then click Next. screen.

3. Click Yes at the registration screen.

Dr. DivX
Double click DrDivX106.exe. 9. Copy austinmontauge-3minutes to

2. Click Run on the Open File security C:\program files\divx\dr.divx.
wz-arnmg dialog box. To run the benchmark:

3. Click Next to Welcome note. 1. Double-click pr. pivx on the desktop.
C_Ihoose I accept the ter_ms in the 2. Click Continue with trial version.
license agreement and click Next. _ ) )

5. Click Next to choose components. 3. Click Video file button.

6. Click Install to select default location. 4 Sélect ausunmontauge_#ln_utes'

7. Click Finish upon install. 5. Click Next on select audio input.

8 6. On Choose output select next.

Reboot the system.
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7.

Select Encode, then Start Timer on
encode video.

8. When encode completes stop timer.

Razor Lame Ver. 1.1.5

1.

9.
10. Input the burned CD into the computer.

Install ezcddax6.exe to convert ripping
CD to.wav format.

Click Run on the Open File security
warning dialog box

Click Next to continue ripping from
Easy CD-DA Extractor Setup.

Click Next to install program into
default folder.

Click Finish.

Insert Pink Floyd - Wish You Were
Here Audio CD into drive.

Go to Start > Programs > Easy
CD-DA Extractor 6 > Easy CD-DA
Extractor.

Click Evaluate the Software.

a. Select Device to Hitachi GD-2000

1000 to reflect the CDROM is
installed on the computer.

b. Select all tracks.

Click Copy to continue.

d. In the dialog box, change output

folder to C:\Pink Floyd.

e. Go to Integrated Formats tab;

choose .wav (standard) in the first
drop down box.

f. Click Start Copying to copy files.

Burn the raw files to another CD.

11. Choose the pink Floyd folder.

12. Copy folder from CD to desktop.

13. Install lamewin32.

14. Click I Agree to license agreement.
15. Click Next to install LAME Mp3.

16. Click Install to continue install.

17. Clicks Close.

18. Open RazorLAME shortcut on desktop.

19. Drag the Pink Floyd folder track items
into RazorLAME 1.1.5.

20. Go to Edit menu, choose Lame
Options.

21. Under General tab, increase Bit Rate to
192.

22. Under Advanced tab, change
Optimization to Quality.

23. Under VBR tab, select Enable
Variable BitRate and change Quality
Number to 9.

24. Click Ok to close dialog box.

To run the benchmark:

1. Click Encode to run benchmark.

Note: To view results, Go to View, Last log, and scroll down
to end of file. Before running a second run, delete all
files from the RazorLAME and re-copy prior to starting
run. There is no need to reset the options.

Panorama Factory

1.

Insert the Panorama Factory DVD.

2. At prompt type in 3 to run demo with

four images in 32-bit mode.

3. Do not touch keyboard or mouse while
the demo runs.
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then click Next.

4. When the window with the STEP-6 6. The benchmark time is shown next to
Save and Print your Panorama the Wizard text.
appears the benchmark is complete. 7. Exit the main Panorama window.
3 O_n Atk Window'select Tools > 8. Click No on the save files window.
Timers from the main toolbar.
POV-Ray
1. Download POV-Ray version 3.6.1a from| 6. Click Next at chose destination
http://www.povray.org/download/. location.
Double-click povwin3ea.exe. 7. Click Next to backup and replace files.
Click Run on the Open File security Click Next to select program manager
warning dialog box. groups.
Click Next to Welcome note. 9. Click Next at automatically check for
5. Select I agree to then license window updates.
then click Next. 10. Click Next for start installation.
6. Click Next at chose destination 11. Click Next to supporting us.
location. 12. Click Next to post installment.
7. Click Next to backup and replace files. 13. Click Finish.
gllgllij:ext to select program manager 14. Click OK when render is complete.
. . 15. Copy the povraybench folder from the
9. Click Next at automatically check for CD to the desktop.
updates.
10. Click Next for start installation. Running the benchmark
11. Click Next to supporting us. 1. Double click the POV-Ray v 3.6 icon on
12. Click Next to post installment. th.e desktop.

13. Click Finish. Click OK to the brtag screen. |
14. Click OK when render is complete. 3(;.(—Select Show tip tomorrow and click
Patch for Multi-Threaded 4. Select File > Open from the main

1. Download POV-Ray version 3.7 (latest menu.
version. 5. Select Desktop on the left menu bar.
Double click the povray37.exe file. 6. Select the povraybench folder.

3. Click Run on the Open File security 7. Select benchmark.
warning dialog box. 8. Select Render then Start render from
Click Next to Welcome note. the main menu bar.

5. Select I agree to then license window | 9. The system begins to render the file.
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10. Select Don’t tell me again to the 12. Select the Messages tab to obtain the
render complete sound dialog box then score.
select OK. 13. Record the PPS (pixel per second )

11. Select Don’t tell me again to the no results from the line above the last line
output file dialog box then select OK. in the messages box.

MovieMaker

1. Copy everything from the moviemaker To Run Benchmark
directory on the AMD CD to 1. Run Movie_Maker_bmark32.exe
c:\Temp\Movie_Maker on the local ' - - ) '
system. 2. The Benchmark is completed when the

Results.csv file opens.

Sony Vegas

1. Purchase Sony Vegas. 10. Select Make Movie.

2. Install Sony Vegas per the installation | 11. Select Save to Hard Drive.
instructions from the vendor. 12. Change the file path to:

3. Create a folder named c:\temp\vegas. C:\Temp\Vegas\Reef.avi.

Copy Reef_5min.mpg from AMD CD to | 13. Select Next for the initial encode.

C:\Temp\Vegas. 14. Exit the program when encoding is
5. Copy Reef.vf from AMD CD to completed.
C:\Temp\Vegas\.

6. Copy Vegas_Studio_timing.exe from To Run Benchmark
AMD CD to C:\Program 1. Open a CMD window and change
Files\Sony\Vegas Movie Studio 4.0. d_irectory to C:\Program _

7. Double-click on the icon for vegas Files\Sony\Vegas Movie Studio 4.0.

Studio. 2. Run Vegas_Studio_timing.exe.

8. Deselect the Show at Startup box on| 3. Benchmark is completed when the
the Show Me How splash screen. Results.csv file opens.

9. Open the Reef.vf project from the File Note: If a negative number is displayed in the results file
) menu then the benchmark will need to run again.

Gaming

Futuremark Corporation 3DMark® 2003
1. Double-click 3Dmark2003® 3. Click Next to install 3Dmark2003®.

3dmark03_V360_installer.exe. 4. Click Yes to accept the license
2. Click Run on the Open File Security agreement.
Warning dialog box.
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5. Click Next to install the default
destination location.

Click Next to start copying files.

Enter the registration code and click
Next.

8. Click Ok for registration code
confirmation.

9. Click Finish to complete installation.

Run the Software Benchmark:
Execute 3Dmark2003.

2. Select Do not show this dialog
again > Close.

3. Click Change in Display and CPU
Settings.

4, Select D3D Software T&L under
Rendering Pipeline.

Click Ok.
Click Change under Selected Test.

Select only the first four game tests
under Game Performance.

8. Deselect the remaining test.

AMD Processor Performance Evaluation Guide

o,
10. Click Benchmark to launch the tests.

8.
o,
10. Click Benchmark to launch the tests.

Click Ok.

Note: After each run, exit and restart the

program.

Run the Hardware Benchmark:

Execute 3Dmark2001 SE Pro.

Click Change in Display and CPU
Settings.

Ensure that Double Buffering is set
to Enabled.

Select D3D Hardware T&L under
Rendering Pipeline.

Click Ok.
Click Change under Selected Test.

Select only the first four game tests
under Game Performance.

Deselect the remaining test.
Click Ok.

Note: After each run, exit and restart the

program.

Futuremark Corporation 3Dmark® 2005
9.

1. Execute 3DMark® 2005:
3dmark05_V120_installer.exe.

2. Click Run on the Open File security
warning dialog box.

3. Click Next to install 3Dmark05.

Select I accept the terms of the
license agreement and click Next.

5. Click Next to install to default
Destination Location.

Click Install.
Enter the registration code.
8. Click Ok.

Click Finish to complete installation.

To run the software benchmark:

Execute 3DMark05 from the desktop.

Select Do not show this dialog
again at the tip of the day dialog and
click Close.

Click Select under Tests.

Select Game Test and deselect the
CPU test.

Click Ok.
Click Change under Settings.
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Click Force Software Vertex
Shaders box.

Click Ok.
Click Run 3Dmark.

Run the Hardware Benchmark:

Click Select under Tests.

Select Game Test and deselect the
CPU test.

Click Ok. to the Shaders box.
5. Click Change under Settings.
Click Run 3Dmark.

1. Execute 3DMark05 from the desktop.

Crafty

1. Copy the Crafty files to the C:\ drive. | 3. Open crafty.csv to obtain the scores.

2. Double-click craftybench.exe.

Doom 3

1. Place the Doom3 CD into the CD drive.| 16. Click Yes to not install DirectX.

2. Click Run on the Open File security 17. Click Next to make sure we have the
warning dialog box. latest video drivers.

3. Click Next to Welcome note. 18. Click Finish.

4. Enter CD key click Ok. 19. Double-click the poom3 Icon on desktop.

5. Click OK at valid KEY windows. 20. Click Options.

6. Click Next at welcome screen. 21. Click Systems.

7. Choose I accept the terms in the 22. Click screen size to set to 1024x768.
license agreement and click Next. 23. Click Apply changes.

8. CIick. Next on minimum system 24. Click OK to apply changes.
requirements.

9. Click Next at choose destination 25. Exit DOOMS.
location. To Run Benchmark

10. Click Next at select program folders. 1. Double-click the DOOM3 icon on

11. Click Next to start copying files. desktop.

12. Insert appropriate CD when required. | 2. Press CTRL+ALT+~ to enter console

13. Click Yes at create shortcut to mode.
desktop. 3. Type timedemo demol

14. Click No to register. Note that the first score run is not

15. Select No, I do not want to install representative of subsequent runs.

DirectX at this time and click Next.

5. Record score and click OK.
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Far Cry

1.

Place Far Cry CD into the CD drive.

9. Click Next on start copying files.

2. Click Run on the Open File security 10. Click Finish.
warning dialog box. 11. Copy demo folders cooler and pier to
3. Click Next to Welcome window. c:\program files\ubisoft\crytek\far
Choose I accept the terms in the grye}lc?cgels to replace the folders in the
license agreement and click Next. Ir ry.
Click Next on destination location. 12. Create one shortcut.
Click Next to select features. 13. Copy the far cry shortcut on the
desktop.
De-select install adobe acrobat reader
then Click Next. 14. Renarpe the new far cry shortcut to far
_ _ _ cry pier.
8. Click Next to start copying files. 15. Edit the shortcut command line to
9. Insert the CD's when required. read:
10. Deselect View readme and Register Far "C:\Program FileS\Ubi"SOft\Crytek\Far
Cry then click Next. Cry\Bin32\FarCry.exe" -devmode
) L. "#demo num runs=3" "#demo quit=1"
11. Click Finish. "map pier" "demo coolerOl".
12. Click No to install farcry xfire. 16. Double-click the far cry icon on
I th e desktop.
Install the Patc. Far CRY
or Far 17. Click OK on far cry configuration tool.
Double click facry_v_1.3.exe. _ ]
_ _ _ 18. Select Video options tab.
2. Click Run on the Open File security .
warning dialog box. 19. Select Very high.
3. Click OK on choose setup language. 20. Click OK.
Click Next on welcome. 21. Exit game when it starts.
5. Choose I accept the terms in the Run the Benchmark
license agreement and click Next. ) .
Double click the far cry pier shortcut.
6. Click Next on destination location.
_ 2. Open folder c:\program
Click Next on select features. files\ubisoft\crytek\far cry\levels\pier.
Choose I accept the terms in the 3. Open pier.txt file to view results.
license agreement and click Next.
Half-Life 2
1. Purchase Half-Life 2. 3. Copy demo files from AMD CD
2. Install according to manufacturers at_coast_05_rev7.dem and

installation guide.

at_prison_05_rev7.dem to c:\program
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files\\valve\steam\steamapps\"USERN | 18. Change texture detail to High.
AME"\half-life 2\hI2. 19. Change filtering mode to anisotropic
Note: “USERNAME” is the name of the user that was 8x.
entered during game installation. )
Disconnect the network cable. 20. Change water detallito Reflect World.
5. Double-click the Ha1f1ife 2 icon on the 21. Change shader detail to High.
desktop. 22. Change shadow detail to High.
6. Click Start in offline mode. 23. Change wait for vertical sync to
7. Click Options. D|-sable.
8. C(Click Keyboard. 24 CIka oK.
9. Click Advanced. 25. Click OK.
10. Select Enable developer content, To Run Benchmark
click OK. 1. Press shift + ~ to bring up the
11. Select the Video tab. console.
12. Change resolution to 1024x768. Type timedemo at coast 05 rev7.
13. Change display mode to Full screen. Read score in FPS from bottom line of
14. Change aspect ratio to Normal. console.
15. Click Advanced. Type timedemo at prison 05 rev7.
16. Change model detail to High. 5. Read score in FPS from bottom line of
console.
17. Change antialiasing mode to 4x.

Star Wars - Jedi Knight II: Jedi Outcast (1024x768x32)

1. Click Install to install Jedi Knight II. 10. Click Continue to install.
2. Click Run on the Open File security 11. Click OK to continue.
warning dialog box. 12. Unzip assets2.pak3 found in
3. Click Next to install Jedi Knight II: Jedi \GameData\Base folder.
Outcast. 13. Extract the file jk2ffa.dm 15 to the
Click Yes to accept License Agreement. \Base\Demos folder and then rename
Click Automatic installation. the demo to jk2ffa.dm 16.
Click Yes to confirm automatic 14. Cppy the renamed demo file to a new
) . directory, Demos off of the path
installation.
c:\program Files\LucasArts\Star Wars
7. Click Exit installation. JK II Jedi Outcast\GameData\base.
Install patch Jkiiup104.exe. 15. Create shortcut to desktop for Jedi
9. Click Run on the Open File security Kf”ght IT Multi Player: c:\Program _
Warning dialog box Files\LucasArts\Star Wars JK II Jedi
Outcast\GameData\jk2mp.exe.
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16.

17.

18.

Right click Shortcut to jk2mp from
desktop and select Properties.

Type +set sv_cheats 1 at the end of
the Target Location. For example,
Target Location should read:
c:\Program Files\LucasArts\Star Wars
JK ITI Jedi
Outcast\GameData\jk2mp.exe +set
sv_cheats 1.

Click Ok to close shortcut.

Run the Benchmark

AMD Processor Performance Evaluation Guide

6. Click Close.

7. Click Don’t send on the error report
screen.
Reboot.

9. Double-click Shortcut to jk2mp.
10. Click Setup.
11. Click Video.

12. Select 1024x768x32 for Video Mode
and 32-bit for Color Depth.

13. Click Apply Changes.

1. Double-click Shortcut to jk2mp. 14. Click Yes to continue to Main Menu.
2. The first time the program is executed | 15 press Shift + ~
a data execution prevention error will ' '
occur. 16. Type timedemo 1.
3. In the Data Execution Prevention 17. Type demo jk2ffa.
dialog box, click Change settings. 18. Press Enter.
Click on the box in the window. 19. Press Shift + ~ and scroll up to see
5. Click OK. the score.
Pain Killer
1. Place Pain Killer CD into the CD drive. Install patch
2. Click Run on the Open File security Double-click painkiller_161.exe.
warning dialog box. 2. Click Run on the Open File security
3. Click Next to Welcome window. warning dialog box.
4. Click yes on the license agreement. Click Next on welcome.
5. Click Next destination location. 4. Click Yes to Software license
6. Click next on program folders. aqreement. o _
2 Click next to install. 5. leck Next destl-natlon location.
8. Enter CD key press enter. 6. Click CIosg aga-m.-
9. Insert CD's as required. 7. Double-click painkiller_162.exe.
. . 8. Click Run on the Open File security
10. gg(e‘:cct no to not install gamespy click warning dialog box.
11. Deselect install DirectX 9.0b 9. Click Next on welcome.
. 10. Click Yes to Software license
12. Click Close.

agreement.
11. Click Next destination location.
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12. Click CLOSE to finish.

13. Double-click
painkillerpatchl.64updatefrom1.62wit

hreadme.exe.

14. Click Run on the Open File security

warning dialog box.
15.
16.

Click Next on welcome.

Click Yes to Software license
agreement.

AMD Processor Performance Evaluation Guide

17. Click Next destination location.
18. Click Close to finish.

To run benchmark

[N

Double click launch painkiller shortcut.
Press Shift + ~.

Type benchmark c5L2.

Quake III Demo2 (1024x768x32)
1. Install Quake III: Q3Ademo.exe.

2. Click Run on the Open File Security
Warning dialog box.

3. Click Next to install the Quake 3 Arena
Demo.

4. Click Yes to accept the license
agreement.

5. Click Next twice to install the default
destination location.

6. Click Close to complete the setup.

Run the Benchmark:
1. Execute Quake3 from the start menu.

Note: A data execution prevention error
occurs the first time the program is
executed.

2. Click Change Settings at the Data
Execution Prevention Screen.

3. Select the box in the window.
Click OK.
5. Click Close Message.

6. Click Don’t Send on the Error Report
screen.

Reboot the system.

Execute Quake3 from Start menu.
9. Click Setup.
10.
11.

Click System.

Click Video Mode to select
1024x768.

Click Color Depth to select 32 Bit.
Click Accept.

Press Shift+~ for the console
command view.

12.
13.
14,

15. Type the following commands to
configure and run the demo:
s_initsound 0

snd restart

Press Shift+~

com maxfps 0

vid restart

Press Shift+~

timedemo 1

demo demo002

16. Press Enter to launch the demo.
17. Press Shift+~ to view results.
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Return to Castle Wolfenstein Enemy Territory(1024x768x32

1.
2.

10.
11.

12.
13.

14.

15.
16.

17.

18.

Double Click woldet.exe

Click Install and click Next to install
Return to Castle Wolfenstein Enemy
Territory.

Click Next on the Welcome screen.

Select I Agree to accept the License
Agreement.

Click Next for Minimum System
Requirements.

Click Next to Punkbuster.

Click Yes to agree to the software
license agreement.

Click Next to install to default
Destination Location.

Click Next to install to default Program
Folder.

Click Install to start the installation.

Click Yes to create shortcut on
desktop.

Click Finish to complete setup.

Double-click the install patch: et
patch_2_60.exe.

Click Run on the open file security
warning dialog box.

Click Next to install Patch.

Click I agree to accept License
Agreement.

Click Next to install to default
Destination Location.

Click Install to Start Installation.

19.
20.
21,

22,

23.

24,
25.
26.
27.
28.
29.
30.
31.
32.

33.
34.

Click Ok to continue installation.
Click Finish to complete installation.

Create a directory called demos in the
c:\Program Files\Wolfenstien Enemy
territory\ETMain\Demos and copy
ACE2.dm_83 to that directory.

Execute Wolfenstein Enemy Territory
from the desktop.

At create profile window, click
connection and select lan/cable/
dsl.

Enter a name for the player alias.
Click Create.

Click Options, System.

Select Video quality to change to high.
Click Apply.

Click Yes.

At Confirm Video Changes, click Yes.
Click Options > View.

Select the following options:

Click Mission timer to select Off.
Reinforcement timer Off.

Cursor Hint Off.

Crosshair pulsing No.

Ejecting Brass High.

Corona distance Extreme.

Q@ ™0 a0 oo

Wall mark lifetime Long.
Select Back.
Click Quit to exit game.
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To run the benchmark: 3. Type Timedemo 1.
1. Execute Wolfenstein Enemy Territory Type Demo ACE2.
from the desktop. 5. Press Shift + ~ to view the demo
2. Press Shift + ~ to open the console. results.
Splinter Cell
1. Install Splinter Cell from CD. 14. Double click to install patch
2. Click Run on the Open File security ;Cijsl—é::‘zgitg;—l'ZB (version
warning dialog box T ' e
3. Click Next to continue. 15. Click Ok to finish patch completion.
Click No to update current version of 16. Go to C:\Program Files\Ubisoft\Splinter
DX9.0. Cell\System\sclow.bat.
5. Click Next to accept license 17. Right click sclow.bat and select Edit.
agreement. 18. The source to the batch file is included
6. Click Next to continue. in the appendix.
7. Click Next to continue. To run the benchmark:
8. Click Next to continue. 1. Create a shortcut to the batch files
9. 1Insert Disc 2 and click OK. stored in the directory noted above.
10. Insert Disc 3 and click OK. Input Splinter Cell CD3 into drive.
11. Click Next to continue. Double-click the Splinter Cell file on the
) _ desktop.
12. Chose Never Register and Click 4. Open the folder c:\program files\ubi
Cancel. !
_ o soft\splinter cell\system.
13. Click Finish. 5. Open the file timedemoresults.xls to
view results.
Unreal Tournament 2004
1. Place the Unreal Tournament 2004 CD 7. Click Next at the components to install
into the CD drive. screen.
2. Click Run on the Open File security Click Install.
warning dialog box. 9. Click Finish.
3. Select English at the language select
dialog box and click Next. Install the Patch
Click I agree at the license screen. 1. Click on ut204-winpatch3355.exe
5. Enter the CD-key click Next. Io.cated on the CD.
Click Next at the destination location 2. Click Next.
screen. 3. Click I agree at the license screen.
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Click Next at the destination location
screen.

Click Install.
Click Finish.

Copy bench2k4 .exe from the AMD CD to
c:\ut2004\system.

Copy maxdetail.ini,
maxdetailuser.ini, flybyexec.txt,

AMD Processor Performance Evaluation Guide

and botmatchexec.txt from the AMD
CD to c:\ut2004\benchmark\stuff.

To Run Benchmark

Double-click bench2k4.exe from the
folder c:\ut2004\system.

Select 1024x768
Click Start.
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AMD's Results

Using the system configuration described in Table 3 on page 23, Table 1 on
page 22, and Table 4 on page 24, and the benchmark configuration and testing
methods recommended on page 30, AMD'’s results are presented in the following
graphs. Contact AMD if you have any questions about the performance of any
AMD microprocessor.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Overall Benchmark Results

AMD Athlon™ 64 4000+’ 100.0 %
I

AMD Athlon™ 64 4800+ 120.6 %
I

AMD Athlon 64 FX-57 1.7 %

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4 :
Extreme Edition (3.73 GHz) 98.6 %
50% 75% 100% 125%

"This model number indicates relative software performance among AMD processors in a 32-bit environment.

Figure 4. AMD Athlon™ 64 FX-57 Processor Overall
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Table 6. Productivity Overall

Processor Result
AMD Athlon™ 64 4000+ 100.0%
AMD Athlon 64 4800+ 121.8%
AMD Athlon 64 FX-57 111.0%
Intel Pentium 4 3.8 GHz 101.1%
Intel Pentium 4 Extreme
edition 3.73 GHz 102.8%
1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

Table 7. BAPCO® sysmark® 2004
Productivity (ver. 1.0 patch 2)

30579 Rev. 3.71 June 2005

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Productivity Overall Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

1.0 %

1 |
101.1 %

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

I I
50% 75% 100% 125%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

Processor Score | Result
AMD Athlon™ 64 4000+'| 214.3 [100.0%
AMD Athlon 64 4800+' | 239.3 |111.7%
AMD Athlon 64 FX-57 233.0 [108.7%
Intel Pentium4 3.8 GHz [ 219.0 |102.2%
Intel Pentium 4 Extreme o
edition 3.73 GHz 224.0 104.5%
1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

BAPCO® SYSmark® 2004 Office Productivity (ver. 1.0 patch 2) Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

I I
75% 87.5% 100% 112.5% 125%

Table 8. Ziff Davis Media Inc.’s Business
winstone® 2004 v1.01!

Processor Score | Result
AMD Athlon™ 64 4000+!| 30.4 100.0%
AMD Athlon 64 4800+' | 31.7 |104.2%
AMD Athlon 64 FX-57 33.7 111.0%
Intel Pentium 4 3.8 GHz 27.5 90.4%
Intel Pentium 4 Extreme o
edition 3.73 GHz 27.9 | 91.8%
1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Ziff Davis Media Inc.'s Business Winstone® 2004 (ver 1.0I) Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

100%

|
50% 75% 125%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.
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Table 9. Ziff Davis Media Inc.’s Business
winstone® 2004 Multitasking!

Processor Score | Result
AMD Athlon™ 64 4000+'| 3.3 [100.0%
AMD Athlon 64 4800+! 4.3 [129.4%
AMD Athlon 64 FX-57 3.7 110.1%
Intel Pentium 4 3.8 GHz 3.6 106.4%
Intel Pentium 4 Extreme o
edition 3.73 GHz 3.6 [107.5%
1This model number indicates relative software performance
among AM D processors in a 32-bit environment.
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AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Ziff Davis Media Inc.’s Business Winstone® 2004 Multitasking Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57 110.1 %

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

75% 100% 125%

150%

Table 10. WinRAR Overall

Processor Score | Result
AMD Athlon™ 64 4000+'| 27.0 100.0%
AMD Athlon 64 4800+' | 26.7 |101.4%
AMD Athlon 64 FX-57 24.1 112.2%
Intel Pentium 4 3.8 GHz 31.6 85.6%
Intel Pentium 4 Extreme o
edition 3.73 GHz 29.2 | 92.6%
1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

Table 11.PC World Magazine
Worldbench™ 5 (May 10, 2004
with SP2 Reg Edit)

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

‘WinRAR (version 342) Benchmark Results

AMD Athlon™ 64 4000+’

AMD Athlon™ 64 4800+’

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

I
50% 75%

100%

125%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

PC World Magazine Worldbench™ 5 (May 10, 2004 with SP2 Reg edit)

AMD Athlon™ 64 4000+'

Processor Score | Result
1 o
AMD Athlon™ 64 4000+ 108.0 |100.0% AMD Athlon™ 64 4800+
AMD Athlon 64 4800+' | 116.0 [107.4%
AMD Athlon 64 FX-57
AMD Athlon 64 FX-57 117.0 |108.3%
Intel Pentium4 3.8 GHz [ 102.3 | 94.8% Intel Pentium® 4 570
(3.8 GHz)
Intel Pentium 4 Extreme o
edition 3.73 GHz 103.0 | 95.4% Intel Pentium® 4
Extreme Edition (3.73 GHz)
1This model number indicgtes relatlive sgftware performance 50% 75'% 100% 125%
among AM D processors in a 32-bit environment.
'This model number indicates relative software performance among AMD processors in a 32-bit environment.
1 Tests performed without independent verification by the VeriTest testing division of 53

Lionbridge Technologies Inc. (VeriTest) nor Ziff Davis Media Inc. and that neither Ziff Davis
Media Inc. nor VeriTest make any representations or warranties as to the results of the tests.
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Table 12. Remote Collaboration

Processor Score | Result
AMD Athlon™ 64 4000+'| 1310.0 |100.0%
AMD Athlon 64 4800+' | 690.0 |189.9%
AMD Athlon 64 FX-57 1118.7 |117.1%
Intel Pentium4 3.8 GHz [ 1081.0 [121.2%
Intel Pentium 4 Extreme o
edition 3.73 GHz 1086.0 1120.6%
1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

Table 13.Travel Ready

Processor Score | Result
AMD Athlon™ 64 4000+'| 295.5 |100.0%
AMD Athlon 64 4800+' | 230.5 [128.2%
AMD Athlon 64 FX-57 270.0 [109.4%
Intel Pentium4 3.8 GHz | 265.0 |111.5%
Intel Pentium 4 Extreme o
edition 3.73 GHz 267.0 1110.7%
1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Remote Collaboration Benchmark Results

AMD Athlon™ 64 4000+’

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570

3.8 GHz) 1212 %

Intel Pentium® 4
Extreme Edition (3.73 GHz)

60% 95% 130% 165%

30579 Rev. 3.71 June 2005

200%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Travel Ready Scenario Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570

(3.8 GHz) 1.5 %

Intel Pentium® 4
Extreme Edition (3.73 GHz)

75% 100% 125%

150%

'This model number indicates relative software performance among AMD processers in a 32-bit environment.
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Table 14.Digital Media Overall

Processor Result

AMD Athlon™ 64 4000+" 100.0%

AMD Athlon 64 4800+" 134.2%

AMD Athlon 64 FX-57 114.0%

Intel Pentium 4 3.8 GHz 105.6%
Intel Pentium 4 Extreme

edition 3.73 GHz 105.1%

1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

Table 15.BAPCO® sysmark® 2004
Internet Content Creation

edition 3.73 GHz

Processor Score | Result

AMD Athlon™ 64 4000+| 230.7 [100.0%
AMD Athlon 64 4800+ | 342.0 |148.3%
AMD Athlon 64 FX-57 264.0 (114.5%
Intel Pentium4 3.8 GHz | 258.7 |112.1%
Intel Pentium 4 Extreme 258.3 |112.0%

1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

Table 16.Content Creation Winstone®
2004 v1.0

Processor Score | Result

AMD Athlon™ 64 4000+'| 38.8 [100.0%
AMD Athlon 64 4800+! 46.1 118.6%
AMD Athlon 64 FX-57 43.6 112.4%
Intel Pentium 4 3.8 GHz 37.1 95.4%
Intel Pentium 4 Extreme 36.9 95.0%

edition 3.73 GHz

1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

AMD Processor Performance Evaluation Guide

AMD Athlon™ 64 FX-55 Processor Performance Benchmarks

Digital Media Overall Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

75% 100% 125%

150%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

BAPCO® SYSmark® 2004 Internet Content Creation Benchmark Results
—

AMD Athlon™ 64 4000+' 100.0 %

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570

@.8 GHz) 112.1 %

Intel Pentium® 4
Extreme Edition (3.73 GHz)

I
75% 100% 125%

150%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Content Creation Winstone® 2004 ver. 1.0l Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50% 75%

100%

125%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.
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AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Table 17.Dr. DivX (Version 1.0.6)2

Processor Score | Result
AMD Athlon™ 64 4000+'| 409.7 |[100.0%

AMD Athlon 64 4800+ | 271.3 |151.0%

AMD Athlon 64 FX-57 356.0 (115.1%
Intel Pentium4 3.8 GHz | 447.3 | 91.6%

Intel Pentium 4 Extreme
edition 3.73 GHz

449.7 | 91.1%

1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

Table 18.RazorLAME MP3 Encoder
(version 1.1.5.1342)

Dr. DivX (version 1.0.6)

AMD Athlon™ 64 4000+’

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50%

115.1 %

75%  100%

125%  150%

175%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

Processor Score | Result

AMD Athlon™ 64 4000+'| 238.0 [100.0%

AMD Athlon 64 4800+ | 238.3 | 99.9%

AMD Athlon 64 FX-57 204.0 (116.7%

Intel Pentium 4 3.8 GHz | 246.0 | 96.7%

Intel Pentium 4 Extreme

edition 3.73 GHz 251.0 | 94.8%

1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

RazorLAME MP3 Encoder (version 1.1.5.1342)

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50%

75%

116.7 %

100%

125%

Table 19.Panorama Factory (version 3.3)

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon 64 FX-57 110.2 |114.9%

Processor Score | Result AMD Athlon™ 64 4000+

AMD Athlon™ 64 4000+| 126.5 [100.0%
AMD Athlon™ 64 4800+!

AMD Athlon 64 4800+ | 123.3 |102.6%
AMD Athlon 64 FX-57

Intel Pentium4 3.8 GHz | 128.2 98.7%

Intel Pentium 4 Extreme

edition 3.73 GHz 128.7 | 98.3%

1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Panorama Factory (version 3.3)

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50%

1
75%

100%

125%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

56 2 Tests performed without independent verification by DivXNetworks, Inc., its parents,
subsidiaries, and affiliates. DivXNetworks, Inc., its parents, subsidiaries, and affiliates make
no representation or warranty as to the results of the tests.
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Table 20.POV-Ray (version 3.7.4)

Processor Score | Result

AMD Athlon™ 64 4000+'|21998.2(100.0%

34757.1|158.0%

AMD Athlon 64 4800+!

AMD Athlon 64 FX-57 24656.0(112.1%

Intel Pentium 4 3.8 GHz |25065.7]113.9%

Intel Pentium 4 Extreme

edition 3.73 GHz 109.7%

24125.8

1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

Table 21.Sony Vegas Studio (version 4.0)

Processor Score | Result
AMD Athlon™ 64 4000+'| 163.0 |100.0%
AMD Athlon 64 4800+' | 87.7 |185.9%
AMD Athlon 64 FX-57 146.7 |111.1%
Intel Pentium4 3.8 GHz | 131.7 [123.8%
Intel Pentium 4 Extreme o
edition 3.73 GHz 127.7 1127.7%
1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

Table 22. Microsoft® Movie Maker
(version 5.1)

Processor Score | Result
AMD Athlon™ 64 4000+'| 169.7 |100.0%
AMD Athlon 64 4800+' | 129.0 |131.5%
AMD Athlon 64 FX-57 147.3 |115.2%
Intel Pentium4 3.8 GHz | 144.7 |117.3%
Intel Pentium 4 Extreme o
edition 3.73 GHz 144.3 1117.6%
1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

AMD Processor Performance Evaluation Guide

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

POV-Ray (version 3.7.4)

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

75%

112.1 %

113.9 %

I
100% 125% 150%

175%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Sony Vegas Studio (version 4.0) Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50%

100% 150%

200%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Microsoft® Movie Maker (version 5.1) Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50%

125%

75%

100%

150%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.
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Table 23.Computer Gaming Overall

Processor Result
AMD Athlon™ 64 4000+ 100.0%
AMD Athlon 64 4800+" 107.4%
AMD Athlon 64 FX-57 110.2%
Intel Pentium 4 3.8 GHz 85.7%
Intel Pentium 4 Extreme
edition 3.73 GHz 88.8%
1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

Table 24.Futuremark Corporation

3pMark® 2003 (Hardware)
(Patch 340)

Processor Score | Result

AMD Athlon™ 64 4000+'|13405.0(100.0%

AMD Athlon 64 4800+' |13456.7|100.4%

AMD Athlon 64 FX-57 [13748.0|102.6%

Intel Pentium 4 3.8 GHz |13415.0[{100.1%

Intel Pentium 4 Extreme

edition 3.73 GHz | 136130

101.6%

1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

Table 25. Futuremark Corporation

3DMark® 2003 (Software)
(Patch 340)

Processor Score | Result
AMD Athlon™ 64 4000+'| 3666.7 [100.0%
AMD Athlon 64 4800+! | 4203.7 |114.6%
AMD Athlon 64 FX-57 4105.3 [112.0%
Intel Pentium 4 3.8 GHz | 3244.7 | 88.5%
Intel Pentium 4 Extreme
edition 3.73 GHz | 33897 | 92.4%
1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

30579 Rev. 3.71 June 2005

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Computer Gaming Overall Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+’

AMD Athlon 64 FX-57 110.2 %

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50%

I
75%

100%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

125%

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Futuremark Corporation 3DMark® 2003 Hardware (Patch 340) Benchmark Results

AMD Athlon™ 64 4000+’

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

100%

I
95% 97.5% 102.5%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

105%

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Futuremark Corporation 3DMark® 2003 Software (Patch 340) Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57 112.0 %

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50% 100%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

75%

125%
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Table 26.Futuremark Corporation

3pMark® 2005 (Hardware T&L)

edition 3.73 GHz

Processor Score | Result

AMD Athlon™ 64 4000+!| 5727.0 [100.0%
AMD Athlon 64 4800+! | 5745.0 |100.3%
AMD Athlon 64 FX-57 | 5764.3 [100.7%
Intel Pentium 4 3.8 GHz | 5712.3 [ 99.7%
Intel Pentium 4 Extreme 5735.3 |100.1%

1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

Table 27.Futuremark Corporation

3DMark® 2005 (Software T&L)

AMD Processor Performance Evaluation Guide

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Futuremark Corporation 3DMark® 2005 (D3D Hardware T&L) Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

95%

I I
97.5% 100% 102.5% 105%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

edition 3.73 GHz

Processor Score | Result

AMD Athlon™ 64 4000+!| 1107.7 [100.0%
AMD Athlon 64 4800+! | 1470.7 |132.8%
AMD Athlon 64 FX-57 1244.7 [112.4%
Intel Pentium 4 3.8 GHz | 996.7 90.0%
Intel Pentium 4 Extreme 1034.0 | 93.3%

1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

Table 28. Half-Life 2 (version 1.1.0 using

at_coast_05_rev7.dem)

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Futuremark Corporation 3DMark® 2005 (D3D Software T&L) Benchmark Results

AMD Athlon™ 64 4000+'
AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

: ®
Intel Pentium® 4 570 90.0

(3.8 GHz) %

Intel Pentium® 4
Extreme Edition (3.73 GHz)

75% 100% 125%

150%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

edition 3.73 GHz

Processor Score | Result

AMD Athlon™ 64 4000+'| 120.4 [100.0%
AMD Athlon 64 4800+! 121.0 |100.6%
AMD Athlon 64 FX-57 131.8 |109.5%
Intel Pentium 4 3.8 GHz 93.8 78.0%
Intel Pentium 4 Extreme 97.8 81.3%

1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Half-Life 2 (version 1.0.1.0 using at_coast_05_rev7.dem)

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

I
50% 75%

125%

100%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.
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Table 29. Half-Life 2 (version 1.1.0 using
at_prison_05_rev7.dem)

Processor Score | Result
AMD Athlon™ 64 4000+'| 129.7 |100.0%
AMD Athlon 64 4800+' | 131.4 [101.3%
AMD Athlon 64 FX-57 135.7 |104.7%
Intel Pentium4 3.8 GHz | 102.4 | 78.9%
Intel Pentium 4 Extreme
0
edition 3.73 GHz 107.5 | 82.9%
1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

Table 30.Jedi Knights IT Demo
(Patched to 1.04)

Processor Score | Result
AMD Athlon™ 64 4000+'| 218.7 [100.0%
AMD Athlon 64 4800+ 219.0 [100.2%
AMD Athlon 64 FX-57 245.8 [112.4%
Intel Pentium 4 3.8 GHz | 201.0 91.9%
Intel Pentium 4 Extreme o
edition 3.73 GHz 207.6 | 94.9%
1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

Table 31.QuakelIll Arena Demo2 (version

Guide

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Half-Life 2 (version 1.0.1.0 using at_prison_05_rev7.dem)

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50% 75% 100%

125%

30579 Rev. 3.71 June 2005

1.11)
Processor Score | Result
AMD Athlon™ 64 4000+*[475.1 |100.0%
AMD Athlon 64 4800+' |475.1 [100.0%
AMD Athlon 64 FX-57 531.6[111.9%
Intel Pentium 4 3.8 GHz | 445.3 | 93.7%
Intel Pentium 4 Extreme o
edition 3.73 GHz 500.01105.2%

1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Star Wars - Jedi Knights lI: Jedi Outcast Demo (Patched to 1.04)
I

AMD Athlon™ 64 4000+' 100.0 %

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

I
75% 87.5% 112.5%

100%

125%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Quakelll Arena Demo2 (version LII)

AMD Athlon™ 64 4000+’
AMD Athlon™ 64 4800+’

AMD Athlon 64 FX-57 119 %

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)
I

I
50% 75% 100%

125%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.
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Table 32.Return to Castle Wolfenstein
Enemy Territory (version 2.60)

Processor Score | Result
AMD Athlon™ 64 4000+'| 94.0 |100.0%
AMD Athlon 64 4800+' | 94.2 |100.2%
AMD Athlon 64 FX-57 106.5[113.2%
Intel Pentium 4 3.8 GHz | 87.7 | 93.3%
Intel Pentium 4 Extreme o
edition 3.73 GHz 87.6 193.1%
1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

Table 33.Unreal Tournament 2003 Flyby
(version 3355)

Processor Score | Result
AMD Athlon™ 64 4000+'|366.4 |100.0%
AMD Athlon 64 4800+" | 372.4 (101.6%
AMD Athlon 64 FX-57 414.8(113.2%
Intel Pentium 4 3.8 GHz | 304.2 | 83.0%
Intel Pentium 4 Extreme o
edition 3.73 GHz | 3269 [ 89.2%
1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

AMD Processor Performance Evaluation Guide

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Return to Castle Wolfenstein Enemy Territory (version 2.60) (1024 x 768 x 32)

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57 113.2 %

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50% 75% 100%

125%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Unreal Tournment 2004 Flyby (version 3355)

AMD Athlon™ 64 4000+’
AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57 113.2 %

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

I
50% 75% 100%

125%

Table 34.Unreal Tournament 2003
Botmatch (version 3355)

Processor Score | Result
AMD Athlon™ 64 4000+'(142.1|100.0%
AMD Athlon 64 4800+" | 142.6 [100.3%
AMD Athlon 64 FX-57 160.9(113.2%
Intel Pentium4 3.8 GHz | 112.5] 79.1%
Intel Pentium 4 Extreme o
edition 3.73 GHz 115.71 81.4%
1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Unreal Tournment 2004 Botmatch (version 3355)

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50%

75%

100%

125%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.
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Table 35.Splinter Cell (1_1_1) (version

1.2b)
Processor Score | Result
AMD Athlon™ 64 4000+'|114.7 |100.0%
AMD Athlon 64 4800+' | 114.7 |100.0%
AMD Athlon 64 FX-57 126.7 {110.5%
Intel Pentium 4 3.8 GHz | 87.4 | 76.2%
Intel Pentium 4 Extreme
[¢)
edition 3.73 GHz 91.1 179.5%
1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

Table 36.Splinter Cell (1_1_2) (version

30579 Rev. 3.71 June 2005

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Splinter Cell (I_I_I) (version I.2b) Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50% 75% 100% 125%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

1.2b)
Processor Score | Result
AMD Athlon™ 64 4000+'(106.0 [100.0%
AMD Athlon 64 4800+' | 106.6 [100.6%
AMD Athlon 64 FX-57 118.3(111.6%
Intel Pentium 4 3.8 GHz | 83.5 | 78.8%
Intel Pentium 4 Extreme
edition 3.73 GHz 87.2 | 82.3%
1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

Table 37.FarCry (version 1.3.1)

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Splinter Cell (I_I_2) (version |.2b) Benchmark Results

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57 111.6 %

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

1
50% 75% 100% 125%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

Processor Score | Result
AMD Athlon™ 64 4000+'| 90.0 |100.0%
AMD Athlon 64 4800+" | 91.6 [101.8%
AMD Athlon 64 FX-57 100.0(111.2%
Intel Pentium 4 3.8 GHz | 74.9 | 83.3%
Intel Pentium 4 Extreme
[¢)
edition 3.73 GHz 77:6 | 86.3%
1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

FarCry™ version 1.3.1

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

I
70% 85% 100% 115%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.
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Table 38.Painkiller (version 1.64)

Processor Score | Result
AMD Athlon™ 64 4000+'(142.8 1100.0%
AMD Athlon 64 4800+' | 143.1|100.2%
AMD Athlon 64 FX-57 161.2(112.9%
Intel Pentium4 3.8 GHz | 117.3 ] 82.2%
Intel Pentium 4 Extreme o
edition 3.73 GHz 119.6 | 83.8%
1This model number indicates relative software performance
among AMD processors in a 32-bit environment.

Table 39.Crafty (Version 19.19)

Processor Score Result

AMD Athlon™ 64 4000+'|1670528.0/100.0%

AMD Athlon 64 4800+ [3428061.0/205.2%

AMD Athlon 64 FX-57 [1958791.0(117.3%

Intel Pentium 4 3.8 GHz |1335650.0| 80.0%
Intel Pentium 4 Extreme o

edition 3.73 GHz 1307641.7| 78.3%

This model number indicates relative software performance among
AMD processors in a 32-bit environment.

Table 40.Doom3 (Version 1.1)

Processor Score [ Result
AMD Athlon™ 64 4000+ 113.4 (100.0%
AMD Athlon 64 4800+' [113.5[100.1%
AMD Athlon 64 FX-57 119.9|105.7%
Intel Pentium 4 3.8 GHz | 97.3 | 85.8%
Intel Pentium 4 Extreme o
edition 3.73 GHz 101.91 89.8%
1This model number indicates relative software performance
among AM D processors in a 32-bit environment.

AMD Processor Performance Evaluation Guide

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Painkiller (version 1.64) (1024x768x32)

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57 112.9 %

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

50% 75% 100%

125%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Crafty (version 19.19)

AMD Athlon™ 64 4000+'
AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

I
0% 75% 150%

225%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.

AMD Athlon™ 64 FX-57 Processor Performance Benchmarks

Dooma3 (version L.I)

AMD Athlon™ 64 4000+'

AMD Athlon™ 64 4800+'

AMD Athlon 64 FX-57

Intel Pentium® 4 570
(3.8 GHz)

Intel Pentium® 4
Extreme Edition (3.73 GHz)

70%

80%

920% 100%

110%

'This model number indicates relative software performance among AMD processors in a 32-bit environment.
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Appendix A Scripts

This chapter lists the contents of the various batch files AMD used to run
benchmark tests.

Spinter Cell Batch File Content

Below is the contents of the splintercell.bat batch file.

splintercell.exe 1 1 1Tbilisi.scl PLAYTIMEDEMO=1 1 1TbilisiDemo.bin -NOSOUND
RESOLUTION=1024X768 SHADOWLEVEL=LOW SHADOWRESOLUTION=LOW EFFECTSQUALITY=LOW
SHADOWMODE=PROJECTOR

splintercell.exe 1 1 1Tbilisi.scl PLAYTIMEDEMO=1 1 1TbilisiDemo.bin -NOSOUND
RESOLUTION=1024X768 SHADOWLEVEL=LOW SHADOWRESOLUTION=LOW EFFECTSQUALITY=LOW
SHADOWMODE=PROJECTOR

splintercell.exe 1 1 1Tbilisi.scl PLAYTIMEDEMO=1 1 1TbilisiDemo.bin -NOSOUND
RESOLUTION=1024X768 SHADOWLEVEL=LOW SHADOWRESOLUTION=LOW EFFECTSQUALITY=LOW
SHADOWMODE=PROJECTOR

splintercell.exe 1 1 2Tbilisi.scl PLAYTIMEDEMO=1 1 2TbilisiDemo.bin -NOSOUND
RESOLUTION=1024X768 SHADOWLEVEL=LOW SHADOWRESOLUTION=LOW EFFECTSQUALITY=LOW
SHADOWMODE=PROJECTOR

splintercell.exe 1 1 2Tbilisi.scl PLAYTIMEDEMO=1 1 2TbilisiDemo.bin -NOSOUND
RESOLUTION=1024X768 SHADOWLEVEL=LOW SHADOWRESOLUTION=LOW EFFECTSQUALITY=LOW
SHADOWMODE=PROJECTOR

splintercell.exe 1 1 2Tbilisi.scl PLAYTIMEDEMO=1 1 2TbilisiDemo.bin -NOSOUND
RESOLUTION=1024X768 SHADOWLEVEL=LOW SHADOWRESOLUTION=LOW EFFECTSQUALITY=LOW
SHADOWMODE=PROJECTOR

MovieMaker

Below is the source to the Moviemaker PERL script file.

use Win32::GuiTest qw( :FUNC ) ;

use Getopt::Long;

use File::stat;

use Time::localtime;

use Cwd;

my $dir = getcwd;

$dir =~ s/\//\\/g;

###Creating results.csv file
open (INPUT, ">results.csv") || die "Could not open file results.csv : $!\n";
open (OUTPUT, ">>results.csv") || die "Could not open file results.csv : $!\n";
while (<INPUT>)

chop;

print OUTPUT "Total encode time\n \n";
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close (INPUT) ;

close (OUTPUT) ;
#get number of test loops
$| = 1;

30579 Rev. 3.71 June 2005

#print "Please enter how many times you want the test to loop: ";

#sInput = 3;

chop $Input;

print "\nTest will loop 3 times.\n";
for (Sx=0; S$x< 3; Sx++)

{

#Deleting the old files

#Check to see if the file exsists
if (-e "sdir\\demo.wmv")

{

#Delete the file

if (unlink "$dir\\demo.wmv")

{

print "The video file has been deleted.\n";

}

else

{

print "The video file was not deleted: $!\n";

}
}

else

{

print "The video file does not exist.\n";

}

#Starting Vegas Studio

my $Title = "demo32 - Windows Movie Maker";
my $Title2 = "Save Movie Wizard";
my $Title3 = "Progressl";

print "\nWindows Movie Maker Demo\n";
system ("start $dir\\demo32.MSWMM") ;
sleep 2;
WaitWindowLike
sleep 0.50;
SendKeys ("%f");
SendKeys ("m") ;

sleep 1;

ShWnd = WaitWindowLike
PushChildButton ($ShWnd,
sleep 0.50;

SendKeys ("demo") ;
PushChildButton ($ShWnd,
sleep 0.50;

SendKeys ('{TAB 3}');
SendKeys ($dir) ;
SendKeys ('{ENTER}');
sleep 0.50;
PushChildButton

(0, $Title, 0, 0, 0, 60);

(0, $Title2, 0, 0, O,
"&§Next >") or die;

"B&rowse...") or die;

(ShWnd, "&Next >") or die;

60) ;
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sleep 0.50;

PushChildButton ($hWnd, "&Next >") or die;

#Start of the Encoding Process
WaitWindowLike (0, $Title3, 0, 0, 0, 60);
SstartTime = ((localtime->min() * 60) + localtime->sec());
print "Encoding file \n";

#H##H#H#H#Timing the encoding processH#H#H#HH

sleep 10;
$i = 0;
$file = "sdir\\demo.wmv";
SlastTime = ctime(stat (Sfile)->mtime) ;
ScurrentTime = S$SlastTime;
while ($1 == 0)
{
sleep 1;

if (SlastTime eqg ScurrentTime)

{

SlastTime = ScurrentTime;

ScurrentTime = ctime (stat($file)->mtime) ;
ilse
{ $i = 1;

###Calculating Encode time###

SfinishTime = ((localtime->min() * 60) + localtime->sec());
SdeltaTime = $finishTime - S$startTime;
print ("\nTotal encode time is $deltaTime.\n");

{

#Print the results to results.csv
open (OUTPUT, ">>results.csv") || die "Could not open file results.csv : $!\n";
while (<INPUT>)

{

chop;
}
print OUTPUT "$deltaTime, seconds\n";
close (OUTPUT) ;
close (INPUT) ;
}
sleep 0.50;

###Closing Movie Maker
ShWwnd = WaitWindowLike (0, $Title2, 0, 0, 0, 60);
PushChildButton ($hWnd, "Cancel") or die;

sleep 0.50;
SendKeys ('%{F4}');
sleep 2;
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}

##O0pening Results.txt in notepad
system ("start notepad results.csv");
##Playing Video
#system ("start c:\\temp\\Movie Maker\\demo.wmv") ;

Sony Vegas

Below is the source to the Sony Vegas PERL script file.

use Win32::GuiTest gw (SendKeys) ;

use Getopt::Long;

use File::stat;

use Time::localtime;

###Creating results.csv file
open (INPUT, "sresults.csv") || die "Could not open file results.csv : $S!\n";
open (OUTPUT, "s>>results.csv") || die "Could not open file results.csv : $!\n";
while (<INPUT>)

{
}

print OUTPUT "Total encode time\n \n";
close (INPUT) ;
close (OUTPUT) ;
#get number of test loops
S| = 1;
#print "Please enter how many times you want the test to loop: ";
#SInput = 3;
chop $Input;
print "Test will loop S$SInput times.\n";

chop;

for ($x=0; $x< 3; S$X++)

{

#Deleting the old files
#Check to see if the file exsists
if (-e "c:\\Temp\\Vegas\\Reef.avi")

{

#Delete the file
if (unlink "c:\\Temp\\Vegas\\Reef.avi")

{
}
else

{
}

print "The video file has been deleted.\n";

print "The video file was not deleted: $!\n";

}

else

{

print "The video file does not exist.\n";
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}

#Starting Vegas Studio

system ("start moviest40.exe") ;

print "Starting Vegas \n";

sleep 8;

SendKeys ("%f");

print "Opening File Menu \n";

sleep 1;

SendKeys ("o") ;

print "Opening Project \n";

sleep 1;

SendKeys ("c:\\Temp\\Vegas\\Reef.vf");
SendKeys ("{ENTER}") ;

print "Loading Project \n";

sleep 3;

#Creating video file

SendKeys ("%f");

print "Opening Menu 2nd time \n";
SendKeys ('k');

print "Making Movie \n";

SendKeys ('{TAB}');

SendKeys ('{ENTER}');

sleep 1;

SendKeys ('c:\\Temp\\Vegas\\Reef.avi') ;
print "Chosing save location and file name \n";

#Start of the Encoding Process
SendKeys ('{ENTER}');
SstartTime = ((localtime->min() * 60) + localtime->sec());
print "Encoding file \n";
#####H#Timing the encoding process######

$i = 0;
$file = "c:\\Temp\\Vegas\\Reef.avi";
SlastTime = ctime(stat (Sfile)->mtime) ;
ScurrentTime = $lastTime;
while ($i == 0)
{
sleep .2;

if (SlastTime eqg ScurrentTime)

{

SlastTime = ScurrentTime;
ScurrentTime = ctime(stat (sfile)->mtime) ;
else
$i=ll

###Calculating Encode time###
SfinishTime = ((localtime->min() * 60) + localtime->sec());
SdeltaTime = $finishTime - S$startTime;
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print ("Total encode time is $deltaTime.\n");

#Print the results to results.csv
open (OUTPUT, "s>results.csv") || die "Could not open file results.csv : $!\n";
while (<INPUT>)

{
}

chop;

print OUTPUT "S$deltaTime, seconds\n";
close (OUTPUT) ;
close (INPUT) ;
}
sleep 3;
###Closing Vegas
SendKeys ('{TAB}"'

I

)
SendKeys ('{TAB}');
SendKeys ('{TAB}');
SendKeys ('{ENTER}');
sleep 1;
SendKeys ('%{F4}');
sleep 1;

}

###0pening Results.txt in notepad
system ("start notepad results.csv");

Travel Ready Scenario

Below is the source to the Microsoft® Publisher + Nero batch file.
@echo off

rem -- Run RecodeBench --

set LOOPCNT=5

set RESULTFILE=result.csv

set BENCH=.\DualCorel.exe

REM set BENCH=perl DualCorel.pl

set TMPRESULT=.\iResult.tmp

set INTERIM=.\interim.exe

set RECODESRC=C:\RecodeBench

set RECODETGT=C:\NeroRecode

if "$1l"=="" goto useloopdefault

set LOOPCNT=%1

:useloopdefault

if "$2"=="" goto useresultdefault

set RESULTFILE=%2

:useresultdefault

if exist "%$BENCH%" goto readytostart

echo Bechmark Program "$BENCH%" not found
goto end

:readytostart

del %$TMPRESULT%

for /L. %$%I in (1,1,3%LOOPCNT%) do cmd /c %BENCH% $TMPRESULT% %31

70 Scripts Appendi&



AMDZ\

30579 Rev. 3.71 June 2005 AMD Processor Performance Evaluation Guide

REM for /L %%I in (1,1,3%LOOPCNT%) do echo Execute %RESULTFILE%
cmd /¢ $INTERIM% %RESULTFILES <$TMPRESULT$S

goto end

:usage

echo recodeBench <runCount> <resultFile>

:end

if EXIST %$TMPRESULT% del %$TMPRESULT%

Remote Collaboration
This is the Perl script source for the Netmeeting, media encoder, PowerPoint viewer
tests.

#File WMEncoder.pl

#File version 1.0

use Env;

use Win32::GuiTest gw( :FUNC :VK ) ;

SWin32::GuiTest::debug = 0;
my S$Verbose = 0;

use strict;
=headl NAME
File name Wme+NM.pl. app name Wme+NM.exe
=headl SYNOPSIS

Starts WMEncoder script and NM script to run concurrently.
=headl DESCRIPTION

This little application runs starts WMEncoder script and NM script to run
concurrently.

These two scripts knows how to synch to each. Synching is forced by using using
"mixmode" parameter and a shared semaphore.

Task of this app is to act like (or better then) a batch file that starts to
apps with params from different folders

and finishes when they all done.

Paths to child scripts are passed as command line parameters!
=head2 Important Notes

perl v5.8.4 for MSWin32-x86-multi-thread (activestate.com)

=headl AUTHOR

Boris Chernis, AMD
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=headl Requirements

No special requirements, as long as requirements for NetMeeting script and
WindowsMediaEncoder script are met.

=headl TODO ("+" means done)

=headl Would be nice ("+" means done)

Would be nice:

Optional redirection of the console output of each child script

Pass all the parameters in a cnf file whose name is passed as a single param

Same as above with an ability to override a value from cnf file by a value from
command line

Verify target IP.

=headl Notes
TBD = To Be Designed. Search for "TBD" in the code.
=headl Usage
Run with no parameters shows Usage and Examples.

=cut
=headl Comamand line parameters
Counting from O0:
0 Path to NetMeeting script or app. Format: string. Backslashes needs to be
doubled up or replaced by forward slashes.
1 Target IP
2 Path to Windows Media Encoder Script
3 Video clip (like MPEG-2 movie) for Windows Media Encoder to re-code
=cut

main{
my S$SAppName = "Wme+NM";
print "Entering S$AppName Benchmark Test program\n";

my $Usage = "\nUsage:\n"
"Wme+NM.exe PathToNM Script TargetIP PathToWme Script
VideoClipFileName\n";

my SExamples = "\nExamples:\n"
"Relative paths:\n"
"Wme+NM.exe ../../NetMeeting/Script/ 163.181.237.220 ../../
WMEncoder/Script/ ../../Movies/NewOrleal941l.mpeg\n"
"Absolute paths:\n"
"Wme+NM.exe d:\\Benchmarks\\NetMeeting\\ 163.181.237.220
d:\\Benchmarks\\WMEncoder\\ d:/movies/MPEG-2 Movies/NewOrleal941l.mpeg\n"
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"Current directory:\n"
"Wme+NM.exe ./ 163.181.237.220 ./ ./NewOrleal941.mpeg\n"

if (eARGV == 0)
print $Usage;
print $Examples;
print "Exiting S$AppName...\n";
exit;

}

#Debugging Flags
my SbRunNM = 1;

my SbRunWME = 1;
my Smixmode = "mixmode"; # "" to avoid synch om semafore, "mixmode" for synch.
my SEXEorPL = ".exe"; # ".pl" for scripts, ".exe" or "" for executables.

#Pre-defined values of parameters

my S$pathNM = "../../NetMeeting/Script/";

my $TargetIP = "163.181.237.220";

my S$pathWme = "../../WMEncoder/Script/";

my $FileToRecode = "./NewOrleal941l.mpeg"; # has to be full path

# Parsing parameters

SpathNM = $ARGV[0] if (defined $ARGVI[O0]) ;
die "Error: Path for NM script SpathNM does not exist, exiting S$AppName\n"
unless(-e $pathNM) ;

STargetIP = $ARGV[1l] if (defined $ARGVI[1]);
print "TBD: Skipping verification of target IP\n";

SpathWme = $ARGV[2] if (defined $ARGVI[2]) ;
die "Error: Path for WindowsMediaEncoder-9 script SpathWme does not exist,
exiting $AppName\n" unless(-e SpathWme) ;

SFileToRecode = SARGV[3] if (defined SARGVI[3]) ;
die "Error: File $FileToRecode to recode does not exist, exiting $AppName\n"
unless(-e S$SFileToRecode) ;

my $pid NM = fork;
#Following is forked, shared code till (including) unless statement
#print "pid = $pid NM\n";
unless ($pid NM)
{
#NetMeeting process, go to its directory
chdir S$pathNM;

#my $C1i1dCMD = "nm msng.pl 163.181.237.220 10 $mixmode";
#my $ClildCMD = "nm msng" . SEXEorPL . " " . $TargetIP . " 10 " . Smixmode;
my $ClildCMD = "nm msng" . S$EXEorPL . " " . $TargetIP . " 0 " . Smixmode;

print "ClildCMD = $C1ildCMD\n";
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if ($bRunNM) {

system($C1lildCMD) or die "Failed launch $ClildCMD";
}else(

print "Warning: Skipping NM\n";
}

print "\nExit Child\n";
exit;

}

#Parent process continues
defined $pid NM or die "Error: Fork is failed!\n";

#Following 10 prints takes 10 sec and show that parent "process" is alive
#for(my $i=0; $i < 5; $i++){

# print "P\n";

# sleep 1;

#}

#assuming the parent path has not changed, so still can use relative chadir
path
my S$pid WMEnc = fork;
#Following is forked, shared code till (including) unless statement
#print "pid = $pid WMEnc\n";
unless ($pid WMEnc)
{
#WindowsMediaEncoder process, go to its directory
chdir S$pathWme;
my $ClildCMD = "WMEncoder" . SEXEorPL . " " . $SFileToRecode . " 1 "
Smixmode;

print "ClildCMD = $ClildcMD\n";
1f ($bRUnwWME) {
system($C1lildCMD) or die "Failed launch $ClildCMD";
telse(
print "Warning: Skipping WindowsMediaEncoder\n";
}

print "\nExit Child\n";
exit;

}

#Parent process continues
defined $pid WMEnc or die "Error: Fork is failed!\n";

#

# Now it's time to synch up copmlition. After WMEncoder completes we don't need
NM any more,

# so we need to ping it to wrop it up.

#
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print "Parent: waiting for Child $pid WMEnc to finish\n";
waitpid($pid WMEnc, O0);
print "Parent: Child 2 $pid WMEnc has finished\n";

print "TBD: (Skipped) Ping NM to wrap up\n";
print "Parent: Waiting for Child $pid NM to finish\n";

waitpid($pid NM, 0);
print "Patrent: Child 1 $pid NM has finished\n";

print "\nAll done: Exit Parent\n";
exit;
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